
Welcome to PhotoPRINT 5.0v3

View an electronic copy of the full manual by selecting Help>Help Topics in the application.

What's on this CD?
\Goodies - Samples from vendors that make Scanvec Amiable Certified Accessories

\Readme\English\PhotoPRINT Server Readme.wri - this file
\Readme\English\PhotoPRINT Help.pdf- electronic copy of the PhotoPRINT manual
\Readme\English\PhotoPRINT Design Help.pdf- electronic copy of the PhotoPRINT Editor and 
PhotoPRINT DX manual
\Readme\English\Product Registration.pdf - an electronic copy of the registration card
\Readme\English\Color Profiler Help.pdf - an electronic copy of the Color Profiler manual
\Readme\English\Ultra Color Profiler Help.pdf - an electronic copy of the Color Profiler manual for 
PhotoPRINT Server-Ultra
\Readme\English\Ultima Cut Server.pdf - guide to using the cut server application with Mutoh 
cutters
\Readme\English\QRC.pdf - an electronic copy of the Quick Reference Card
\Readme\English\Laser Engraving Manual.pdf - How to send jobs to a laser engraver
\Readme\English\Output on the Gerber Edge.pdf - How to output to a Gerber Edge
\Readme\English\White Ink Printing Guide.pdf - How to print using white ink on Mimaki and 
Roland

\Util\Colorspan - Utility for Colorspan printer and drivers for Videonet network interface
\Util\Encad\Go - Application to send native (RTL) file directly to device from DOS
\Util\Eye-One driver - USB driver for Eye One colorimeter
\Util\Encad\EFPUv30 - Installer for application to send native (RTL) files from Windows. Includes 

an RTL viewer
\Util\Hasp - Hasp key driver and utilities
\Util\Mimaki Firewire - Drivers for Mimaki Firewire port
\Util\Old Hotfolder - Copies of the "Hot Folder" port to install manually
\Util\Rainbow - Rainbow key driver and utilities
\Util\USB-PIA - Windows driver for Macintosh USB-PIA cable
\Util\versacamm_ver.300 - Roland VersaCAMM SP-300 USB driver

What's on CD2 (Output Profiles Installer)?
Color Profiler Installer - Application to install additional ICC profiles

See us online at: http://www.SAintl.biz
Send us suggestions or ideas to: Suggestions@SAintl.biz
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Installer
• Added Polish language.
• Support added for Safenet SHK key. Existing keys can be used, or SHK keys can be 

used for new units.
• License agreement in Chinese simplified no longer shows character corruption.
• English PhotoPRINT.pdf helf file now includes a cover page.
• Mimaki Firewire driver updated to version 2.10.
• Fixed an error "Error in install hotfolder monitor" that could occur during installation.

Hewlett-Packard: DesignJet 9000s
• Hewlett-Packard DesignJet 9000s is no longer password protected.



• After unlocking the driver, insert the Output Profiles CD1 to install color profiles. This 
must be done after unlocking the driver, or no profiles will show up.

• The Output Profiles CD contains only profiles for HP branded media. Profiles for other 
media (3M, Avery, MetaMark) can be downloaded at the http://www.SAintl.biz web site.

• When the 9000s is attached to the PC, it may prompt you with "Found New Hardware". 
The necessary Windows USB driver files for this printer can be found on the installation 
CD in the Util\HP DesignJet 9000s USB driver folder

• Hewlett-Packard DesignJet 9000s driver can now print to multiple printers 
simultaneously.

Color Management
• Added support for new colorimeters – Gretag IO, Spectrocam USB, and Barbieri Spectro 

LFP
• X-Rite DTP-41 can now read strips with fewer errors.
• Global color mapping now prints correct color for Pantone spot colors
• PhotoPRINT Server Ultra now includes an updated version of Gretag Macbeth Profiler 

Maker.
• X-Rite DTP-70 now prints two pages of swatches to reduce read errors on large media.
• Gretag icColor no longer crashes when reading third set of characterization swatches.
• Fixed a crash with PhotoPRINT Server Ultra when generating an ICC profile with a very 

long media name.
• Xerox 8142 / 8160 ICC profiles are no longer included on the Output Profiles CD. They 

can be found in the download section of the SAi website.
• Rendering intents are no longer swapped in Japanese and Korean.

New Drivers
• Asbru: ASBRU_V1000, ASBRU_V1045
• Canon: imagePROGRAF iPF500, imagePROGRAF iPF600, imagePROGRAF iPF700
• Fei Yeung Union: FY-3206S, FY-3204S, FY-2506S, FY-2504S
• Gerber: Solara UV 2
• Graphtec: SignJet Pro JS300-18ES, CraftROBO cc100-20, CraftROBO cc200-20
• Kornit: Kornit 930, Kornit 931
• Mimaki: JV3-130SL, JV3-160SPII, CF-0907-2, CF-0912-2, CF-1215-2, CF-1218-2
• Mutoh: VJ-1204 (ValueJet), Phoenix S
• Neolt: NeoltJet UV 2050, NeoltJet UV 2500, NeoltJet UV 3200
• Roland: AdvancedJET AJ-1000 
• Summa: DC4

Driver Changes
• RunJiang Flora: Drivers are now password protected
• Mutoh PJ-1304NX renamed to PJ-1304NX (Albatros)
• HengXing renamed to King Rabbit
• Hewlett-Packard DesignJet 9000s no longer shows empty message when printer 

requires maintenance in localized versions.
• Mimaki Firewire output can now be sent without any hesitation. Previously, there was a 

slight delay between passes on some prints.
• Foison FY 1808 no longer reports an error on opening job properties.

Fixes
• .BMP files can now be properly processed
• Add setup no longer shows "Vinyl cutters", "Color printers" or "Hybrid devices" for 

products that do not support these.
• Roland VersaCAMM will now detect alignment marks before contour cutting.
• Add media will no longer cause a crash.



• Changing colormode when preview is on will no longer cause a crash.
• Mimaki JV3 160SP, JV3 160SPII and JV3 75SPII now can share presets and profiles.
• No longer receive an out of memory error when copying transparent bitmaps in 

PhotoPRINT DX and PhotoPRINT Editor.
• Files no longer fail to save properly after importing a file from removable media then 

disconnecting the media in PhotoPRINT DX and PhotoPRINT Editor.

Limitations and Known Problems
• AXIS print server requires that "Reverse Telnet Options" be disabled. From a web 

browser, enter the IP address of the AXIS print server then click the Configuration button. 
You will be prompted for a user name and password. The default is "root" and "pass". 
Click OK, then scroll down and set "Reverse Telnet Options Enabled" to "No", then click 
the "Submit TCP/IP settings" button.

• KF, Error and Random diffusion jobs require large amounts of RAM, and Virtual Memory 
because they RIP using 8 bits per pixel. These diffusions also take longer to process 
than the rest.

• Custom Color Mapping will apply the ICC profile from Setup Properties when you import 
a file to view the spot colors. To get raw color values, turn off the "Perform Color 
Correction" option in the Print tab of Setup Properties.

• If you don't reboot after adding a new setup to PhotoPRINT, you will receive the 
message: "Unknown error happened when trying to add a printer to the system. Error 
number = 1796". This occurs because the OS doesn't have access to the "Hot Folder" 
port. Rebooting will solve this.

• Infiniti FY6180, FY6250, FY8180, FY8250: "Add setup failed" message will appear if you 
don't have the Infiniti driver files installed. These files are included on CD which comes 
with the printer. You can download the driver at WWW.GZFEIYEUNG.COM. When 
adding the setup, the custom port won't appear in the list. Select any available port and 
the software will automatically use the correct one.

• Print while RIPing option will not work when there are multiple copies. In this case it will 
RIP entire job then print it.

• Mimaki JV3/4 may give error 10 or print the wrong size if the previous job was aborted. In 
order to avoid this, the job must be canceled on the printer before the next job is sent.

• 2 point contour cut alignment will compensate for scale, however the scale factor is only 
measured in one dimension and applied to both using proportional scaling. This can lead 
to slight mis-registration. Distortion cannot be compensated. Some printers will feed one 
side of the media at a different rate than the other side. This will result in one side being 
longer. Contour cut output will not compensate for this type of feed distortion. These two 
issues are solved by using the new 4 point alignment method.

• Canon W7200, W7250, W8200, W8200PG: requires at least firmware 03.06 in order to 
support TCP/IP communications.

• Colorspan drivers (using VideoNet) supports output to only one device at a time.
• Added system fonts will not appear until you exit and rerun the application.
• Outputting to a SEH print server or to a Roland with built in TCP/IP may give "Open Port 

Failed" during printing. This problem occurs only with Windows XP SP2. The work 
around is to use the "LPR" port with queue set to "lp1", or to setup a shared printer port 
from Windows. See document on CD\Readme\English\TCPIP and SP2.pdf for more 
details on setting up the shared printer port.

• SuperPro 64 bit driver is not yet Windows certified and a prompt will come up during 
install to allow it to install. If you are installing on a 64bit OS then a message will appear 
during installation informing you that the driver has not passed Windows Logo testing. 
Click Continue Anyway in order to install the driver.

• Spot colors mapped in Object Color Control will be overwritten by any in global color 
mapping. Job properties preview doesn't reflect this.

• Output may be slow when using a TCP/IP to LPT adapter using an SEH print server. To 
eliminate pausing, turn on "Fast Mode" from Printer Server>Homepage>configuration>



Print Port.
• Canon imagePROGRAF printers do not allow new media to be added to the list. If you 

are creating a new profile, choose an existing media. This is required because the printer 
needs to know the base media in order to setup printing parameters such as number of 
passes.

Revision History
PhotoPRINT 5.0v2
Build 899
March 24, 2006
Production Fixes
• Linearization and ink limit now show in job properties for jobs sent from RIP and Print. 

This does not affect output, only job properties and the RIP log.
• PhotoPRINT DX now has Vividness control in job properties.
• PhotoPRINT DX now installs PPDs and has option to add desktop printer driver during 

add setup.
• PhotoPRINT SE now has File>Export Preset.
• Presets that install are now all read only. They can still be edited, but to save them use 

"Save As" instead of "Save".
• "None" preset added to default job properties when a new media is added. This is used 

when making a new color profile so that the correct ink limit and linearization are used.
• Preview resolution can now be set in preferences in PhotoPRINT SE.
• Mirroring a tiled job no longer places overlap lines on the wrong edge.

Design Fixes
• Effects>Outline command now allows corner style to be set for line-curve intersections.
• Gerber Edge spectratone2.slb color library has been added.
• Improved text spacing with Casmate SCV import.
• Improved Photoshop plugin filter support.
• Support added for PLT files from localized versions of Gerber Omega.

Installer Fixes
• Rainbow key detection no longer fails on systems that had a previous version of the 

driver installed.
• Dutch software localization is now included.
• Installer can now be configured to remove files from installation for dealer customization.
• Updated color profiler help files now install.
• Updated application help file now installs.

Driver Changes
• Mutoh printer driver no longer gives error message when opening job properties for jobs 

received from the Mac.
• Creation-Kingcut no longer gives error for A-24, A-30, A-36 and A-48 cutters
• ColorSpan BCI toolkit now installs compatible version to allow output, and many models 

converted to use Ferret interface.
• Added ICC profiles for ColorSpan drivers.
• Wild cutter now send correct command to change tools.
• Summa OPOS contour cut alignment now has improved accuracy.
• Hewlett Packard DesignJet 4000 now sets correct options when sending from desktop 

applications
• Seiko 64s no longer gives error, "Printer status is abnormal!" and will stop printing. 
• “Error loading string“ now longer appears when using Encad 750 driver.
• Liyu drivers now support Folder port.
• Kodak 1200 PPDs now install



• Canon W6400PG renamed to imagePROGRAF W6400
• Canon W8400PG renamed to imagePROGRAF W8400
• Canon  imagePROGRAF W8400D added
• Canon imagePROGRAF ICC profiles now install.
• Roland GX-24 no longer gives error message when opening default job properties.
• Hewlett Packard DesignJet 9000s (requires an additional password to unlock)
• JHF renamed to JinHengFeng.

New Drivers
• Asbru: ASBRU_V545C, ASBRU_V645, ASBRU_V745, COMPACT 30, COMPACT 54
• Canon: imagePROGRAF W8400D
• ColorSpan: DisplayMaker 72S, DisplayMaker 72si, DisplayMaker 72sru, DisplayMaker 

72uvx, DisplayMaker 98si, DisplayMaker 98uvx
• DGI: DR-1904T 4C, DR-1904T 6C, VT II-62P, VT II-92P, XP-2506
• Eastech: Eco-8700, Octra UV-6440E, Octra UV-8720E, Octra UV-8740E, Scutum UV-

6440S, Scutum UV-8720S, Scutum UV-8720S-4S, Scutum UV-8740S
• Fei Yeung Union: FY-3206S (3.2m/6color), FY-3204S (3.2m/4color), FY-2506S 

(2.5m/6color), FY-2504S (2.5m/4color)
• Foison: FY1504C, FY1808C, FY6150C, FY6250X
• GongZheng: GongZheng XL
• Graphtec: SignJet Pro JS300
• HengXing: HX-1200, HX-1360, HX-720, HX-800, HX-960
• Hewlett-Packard: DesignJet 9000s (requires optional password)
• Infiniti: Renamed all models to begin with "YF-". Added YF-1232IIIS, YF-18EC, YF-

8180III+, YF-8250III+, YF-UV1612S. Removed: 1218C-6, 1225C-6, 1504C, 3208B, 
3212C, 3212C+, 3308B, 3308C, 3312C, 3360A, 6150C, 6180II, 6250II, 6320LQ, 8180C, 
8180II, 8250II, UV1218

• Inwear: Inwear 4C, Inwear 6C
• JinHengFeng: VISTA 04B, VISTA 04B+, VISTA 04C, VISTA 04C+, VISTA 04C++, VISTA 

04D, VISTA 04D+, VISTA 04D++, VISTA 06A+S, VISTA 06AS, VISTA 06B+S, VISTA 
06BS, VISTA 06C++S, VISTA 06C+S, VISTA 06CS, VISTA 06D++S, VISTA 06D+S, 
VISTA 06DS, VISTA 08A, VISTA 08A+, VISTA 08B, VISTA 08B+, VISTA 08C, VISTA 
08C+, VISTA 08C++, VISTA 08D, VISTA 08D+, VISTA 08D++, VISTA 12A, VISTA 12A+, 
VISTA 16A, VISTA 16A+

• King Rabbit: Rabbit HX-1200, Rabbit HX-1360, Rabbit HX-720, Rabbit HX-800, Rabbit 
HX-960

• MyJet: Diecai-Jet3308, Diecai-Jet3312, Diecai-Jet3312 6C, Diecai-Jet3316, E-Jet3308, 
E-Jet3312, E-Jet3312 6C, E-Jet3316, MyJet1804-K512, MyJet1808-126-Hi, MyJet1808-
128-Hi, MyJet1808-K512, MyJet1812-126-Hi, MyJet1812-126-Hi, MyJet1812-126-Hi 6C, 
MyJet1812-128-Hi 6C, MyJet1812-K512 6C, MyJet1816-126-Hi, MyJet1816-128-Hi, 
MyJet1816-K512, MyJet2204-K512, MyJet2208-126-Hi, MyJet2208-128-Hi, MyJet2208-
K512, MyJet2212-126-Hi, MyJet2212-126-Hi 6C, MyJet2212-128-Hi, MyJet2212-128-Hi 
6C, MyJet2212-K512 6C, MyJet2216-126-Hi, MyJet2216-128-Hi, MyJet2216-K512, 
MyJet2504-K512, MyJet2508-126-Hi, MyJet2508-128-Hi, MyJet2508-K512, MyJet2512-
126-Hi, MyJet2512-126-Hi 6C, MyJet2512-128-Hi, MyJet2512-128-Hi 6C, MyJet2512-
K512 6C, MyJet2516-126-Hi, MyJet2516-128-Hi, MyJet2516-K512, MyJet3304-SP256, 
MyJet3304-SP256-Hi, MyJet3306-SP256 6C, MyJet3308-126, MyJet3308-128, 
MyJet3312-126, MyJet3312-126 6C, MyJet3312-128, MyJet3312-128 6C, MyJet3316-
126, MyJet3316-128, Poli-Jet3308, Poli-Jet3312, Poli-Jet3312 6C, Poli-Jet3316

• Nur: Fresco 18, Fresco 32, Ultima 32, Ultima 5, Tempo, Expedio
• Orasign: FY1218C-6, FY1225C-6, FY1504C, FY3212C, FY3212C+, FY3308C, 

FY3312C, FY3360A, FY3360EC, FY6150, FY6250LQ, FY6320LQ, FY8180C, FY8250B, 
FY8250C, FY8320, UV1612S, W-Jet 160

• Roland: SOLJET PRO II V SJ-1045 EX
• Scitex: Scitex Grandjet, Scitex Grandjet V3, Scitex Grandjet V5



• Technoplot: SolventJet-Basic SP300, SolventJet-Basic SP540, SolventJet-Combi 545, 
SolventJet-Combi 645, SolventJet-Combi 745, SolventJet-Pro 545, SolventJet-Pro 645, 
SolventJet-Pro 745

• Vivagi: Vivagi XL
• Wit-Color Digital: Wit600H12 Fly, Wit600H16 Fly, Wit600H8 Fly, Wit6720H12 Fly, 

Wit720H12 Fly, Wit720H16 Fly, Wit720H8 Fly
• Xerox: 8142, 8160
• Yaselan: YSL-Super

Color Management Changes
• Added support for additional colorimeters: X-Rite DTP-20 X-Rite DTP-70, and Gretag 

iCColor.
• PhotoPRINT Server Ultra can now view settings used to generate an ICC profile, plus 

modify them and re-generate the profile.
• PhotoPRINT Server Ultra can now set the style and size of the swatch target.
• Color target for X-Rite DTP-41 now prints the correct size and can be measured.
• Color Profiler now produced standard ICC profiles and they are named .ICC.
• Unlocking the Color Profiler now adds page nesting and page range to job properties.
• Dutch language no longer has rendering intents swapped.
• PhotoPRINT DX can now set "Use color mapping" in job properties. Previously this 

checkbox was hidden.

PhotoPRINT 5.0v1
Build 837
November 15, 2005

Color Management
• Preview resolution in Job Properties can now be selected in preferences. The higher the 

quality setting, the longer it will take to open job properties, but the less jagged image will 
appear when zooming in. For nested jobs with many files, or for multiple page files with 
many pages, it is recommended to set this to "Low" setting to reduce memory usage.

• PhotoPRINT Server-Ultra includes Gretag-Macbeth powered ICC profile generation. The 
swatch targets and algorithms to generate ICC profiles are licensed from Gretag-
Macbeth to give the best possible color output. For CMYK and CMYKOG profiles we 
support only Eye-one, Spectroscan and DTP-41. CMYKRB profiling is not supported.

• Object Color Control - new tab added to Job Properties for Object Color Control. As the 
cursor is moved over the preview, it will show the object type, colorspace, input value, 
and output value with color management applied.

• Clicking on the preview in Object Color Control will add a color mapping to the list and 
allow you to change the output values.

• Items in advanced color management dialog (rendering intents, input profiles) will dim 
based on what objects are in the loaded file.

• Gretag Eye-One SDK has been updated to improve performance. According to Gretag, 
this will reduce the time before reading each strip and improve swatch recognition to 
improve scanning accuracy. It also adds support for new "rev B. Eye-One Pro" 
colorimeter.

• Spot color mapping table is now stored per setup, not per printer name. This makes it 
possible to have multiple setups of the same device, each with their own mapping table.

• Gradient smoothness (formerly smooth blends) now defaults to off to produce more 
accurate results, and is only available if there are PostScript 3 gradients in the file.

• Printer simulation now allows any ICC profile to be selected for simulation. It is no longer 
limited to devices that have built in drivers.

• Vividness slider and Advanced button added to color adjustment tab of Job Properties.
• Input ICC profiles DefCMYK.icm, DefGray.icm, and DefRGB.icm are no longer installed. 

These were old default input profiles and new ones give better results.



• Ink split was not always applied when printing profiling swatches for a new media.
• Soft proofing in color adjustment tab now applies ICC profile changes without needing to 

turn preview off then on again.
• Shades of Pantone colors now print properly and get mapped to correct output color.
• Ink limit is now applied to colors preserved in Pure Hue.
• Jobs sent from Color Profiler are now immediately added to the queue. There were some 

cases where the job would not show until product was re-launched.
• Added support for 3rd party profiles using CMYKOG
• Multiple ink limit test print now labels each row by the channel name.
• If the color profiler is not unlocked, then the device setup for colorimeter will be disabled.
• Driver options set in the first screen of the color profiler are now applied to the test prints.

Feature Set changes from 4.6v2
• PhotoPRINT SE: Added Preserve pure hue, Export presets, Save presets, Global color 

mapping with Pantone colors, Color bands, Marks, Vividness control
• PhotoPRINT DX: Added Global color mapping with Pantone colors, Color bands, 

Production based tiling, Vividness control
• PhotoPRINT SERVER: Added Object color control, Vividness control
• PhotoPRINT SERVER-PRO: Added Object color control, Vividness control, installs Editor 

automatically

Other Changes
• RIP engine has been updated to Adobe CPSI 3017.102 for Windows.
• RIP engine now supports CMYK overprint.
• Removed preference for "Ignore overprint in PDF" has been renamed to "Ignore 

overprint" and moved to Job Properties CMS tab.
• Added "Borderless" checkbox to Layout tab of properties. When on it will only show 

borderless media and selecting one will automatically fit image to that media to activate 
borderless printing. Borderless is supported by some Epson, Canon and HP printers.

• Updated to the latest version of the Microsoft compiler. This should improve 
performance, memory usage and stability.

• Fixed a thin black line that could appear between copies in some special cases.
• Rotate image to fit media will now also rotate to save media, not just to save tiling.
• Corrupted production preferences no longer cause a crash on startup. Instead, any 

corrupted setups will be removed.
• EPS files now show preview in Add Job in production
• No longer receive message "There is already a setup with that setup name, share name, 

or hot folder name." when trying to add some devices to production.
• Media name in Job Properties no longer shows clipped.
• Preference manager now can save properly even if Production Manager preferences 

aren't yet saved.
• "Print spot colors as process" checkbox moved from first page of separations to edit 

dialog for spot colors as "Apply to all"
• Angled screen now allows LPI values as low as 1.
• Moire free button added to angled screen dialog.
• Print mode can now be localized.
• Cut tab of Properties dialog no longer gives an error if the number of steps is too high.
• Fixed a crash when clicking "Save as default" for a cut job in job properties.
• Output size compensation test print is no longer mirrored.
• Page nesting now defaults to on so that multiple pages, tiles or separations are 

positioned to save media.
• Files can now be overwriting using Save As command from Production. Previously, 

original file would be kept.
• Share name has been changed to never be longer than 12 characters. This way 



Macintosh users can setup the printer when using windows printing protocol.
• Color bands now print with an offset when the job is offset from the origin.

Driver Changes
• Mutoh Ultima now supports multi-segment using firmware 3.00.
• Mutoh cutter now works properly with trimmer.
• Added support for contour cut alignment marks for Graphtec CE3000mk2.
• Mutoh Ultima Cut Server application added to send out contour jobs from PLT files. This 

application is only available for Windows.
• Graphtec 3 point alignment marks removed since there is now support for 4 point.
• Roland VersaCAMM and SOLJET PRO II now supports 1-bit colormode for all 

resolutions.
• Roland hybrid contour cut alignment mark no longer is activated by turning on "crop 

marks" from driver options button. This mark can now be selected in Contour Cut dialog 
and the crop mark option has been removed. The added advantage is that you can use 
any printer, then contour cut on a Roland hybrid.

• Roland SC-500: Newly added media now shows all possible print modes.
• Roland printers now have correct number of passes shown in UI. Previously, selecting 4 

pass at some resolutions would actually print 8 pass.
• Cutter driver options now supports up to 10 custom controls.
• ColorSpan drivers (S, SR, SRU, SX) can now be printed to by updating BCI toolkit 

updated from 3.61 to 3.63. SI and UVR are not yet supported.
• Full support for white ink on Mimaki and Roland printers. See white ink printing guide for 

additional information.
• Fotoba trimmer support added as a new mark style in the labels and marks tab.
• Mimaki SDK updated from 1.70 to 1.80.
• Mimaki error 10/20 has been resolved on some systems by disabling the new preference 

"Compress RIP result". This will make larger temporary files, but be able to output 
without error.

• No longer get "Open Port Failed" when sending to a TCP/IP device where one of the 
digits is 0.

• Desktop printer driver can now print labels and registration marks.
• Summa: option to trim media after job now sends proper command to the cutter.
• Mimaki JV3 / JV4 no longer gives an error message when sending a job while the printer 

is in local mode.

New Cutter Drivers
• Creation-HK renamed to Creation-Kingcut and some models renamed and added.
• Emblem: EC120, EC60
• GCC: SignPal PumaIII P-132S, SignPal PumaIII P-60S
• Graphtec: CE3000MkII-120, CE3000MkII-60, FC7000-100, FC7000-130, FC7000-160, 

FC7000-75
• JiaChen: JC-1100ds, JC-1100H, JC-1350ds, JC-1350H, JC-720ds, JC-720H, JC-850ds, 

JC-850H
• Mutoh: MC-750S, TC-1000, TC-1300, TC-750
• Roland: GX-24
• SeikiTech: SK-1100ds, SK-1100H, SK-1350ds, SK-1350H, SK-720ds, SK-720H, SK-

850ds, SK-850H
• Summa: S140 D, S140 T
• Technoplot: Creation CT1200, Creation CT630, Millennium T1600 Pro, Millennium T610 

Pro, Millennium T750 Pro

New Printer Drivers
• Canon: W6400, W8400



• DGI: DR-1904, XP-2506D
• Dilli Precision: NeoDeluxe UVD-2506, NeoDeluxe UVD-3206, NeoPlus UVP-1606, 

NeoPlus UVP-2506
• Epson: PX-6200S, PX-6500, PX-7500, PX-7500S, PX-9500, PX-9500S, Stylus Pro 4400, 

Stylus Pro 4800, Stylus Pro 7400, Stylus Pro 7800, Stylus Pro 9400, Stylus Pro 9800
• Epson ColorPage EPLC8000 driver removed
• GongZheng: GongZheng GZY
• Graphtec: Doujet 64, JH800-16S
• Liyu: Liyu printer drivers are now included in non OEM products.
• Mimaki: JV3-130SPII
• Mutoh: PJ-2646NX (Osprey 98), RJ-8100 50K, RJ-8100 64K, RJ-8100 87K, SpitFire 100, 

SpitFire 65, SpitFire 90
• MyJet: MyJet3308 8C, MyJet3312 8C
• RunJiang: LJII1800-UV6S
• Seaband: SB-M2
• Teckwin: TeckPro H5000, TeckSmart UV1600
• Wit-Color Digital: Ultra 720, Ultra Max H4, Ultra Max H6, Ultra Max XJ500-3300, Ultra 

Silver H6, Ultra Tiff-3300, Ultra XJ128-3300, Wit180H12 Fly, Wit180H16 Fly, Wit180H8 
Fly, Wit360H12 Fly, Wit360H16 Fly, Wit360H8 Fly, Wit6360H12 Fly, WitMax180H2 Fly, 
WitMax180H4 Fly, WitMax360H2 Fly, WitMax360H4 Fly, WitMax6180H6 Fly, 
WitMax6360H6 Fly

• Yaselan: YSL-D2300S, YSL-D2300T, YSL-D2600H

Installer
• Updated to latest version of InstallShield 10.5 to improve installer performance.
• Dropped support for Windows 98, ME, and NT. Software requirements are now Windows 

2000 or XP.
• Installer now has an option to install only the hardware key driver. In addition, if the driver 

is already installed, this option will automatically be set to unchecked (reducing the long 
wait and the end of installation). The version number of the key driver will be shown in 
the install dialog.

• Clear preferences dialog no longer appears during install, instead there is a checkbox 
during install.

• Reboot is no longer suggested after installation, unless you install over an existing folder.
• ICC CD (CD2) now auto launches when inserted, so there is no longer a need to browse 

for installer.
• Added support for 64bit Windows XP using AMD64 and Intel EM64T (no support for 

Itanium). This only is support with USB keys.
• PhotoPRINT Editor now installs automatically with PhotoPRINT Server Pro version. No 

need to install twice.
• Uninstaller no longer gives an error message that a file cannot be deleted.
• Contour cut guide updated.
• Version number now shows in add/remove programs.
• Help file now includes a full color cover and back.
• Help menu now has command to show color profiler help file along with a link to Scanvec 

Amiable web site.
• CD installer no longer shows progress bar as it starts up, plus no longer installs CHM 

support files during finishing install.
• Updated key drivers to 4.98 and 7.11.
• Help menu for production now includes option to register, go to web site, and view color 

profiler help file.
• Adobe input ICC profiles updated.
• Pantone (R) sample EPS files added.
• PPDs are no longer locked after installation on some systems, blocking the setup of a 



desktop printer driver.

Presets
• Preset selection added to Default Job Properties.
• Export preset can now be saved as "read-only". Previously, this option was ignored on 

export. Because of this, PhotoPRINT SE would not show any pre-made presets.
• Presets now apply cut settings when selected from RIP and Print dialog.
• Cutter Driver options and Use Embedded ICC now get applied from preset in RIP and 

Print dialog.
• Preset list is now alphabetically with all read only presets shown first in brackets.
• Presets now default to save only Color Management, Printer Options, Color Adjustment
• Media and preset list now show more items without scrolling.
• Fixed a preset import issue introduced in Service Pack 1 where Roland VersaCAMM and 

some other presets set the wrong driver options. Any presets saved with SP1 will reset 
driver options.

• Presets changed to a combo box in RIP and Print dialog.

PhotoPRINT DX / PhotoPRINT Editor
• Moved "Overprint" checkbox from DesignCentral to Fill/Stroke Editor.
• Adding a new category to job estimation will no longer show "Type" as dimmed in some 

cases.
• Fixed a crash in Color Specs if default table is closed.
• Adobe Plug-in under the Bitmap menu in the CASmate workspace no longer stays 

grayed out.
• Sending jobs from Mac to PC now keeps correct driver parameters (passes, etc.).
• Snap to toolbar added to snap menu.
• Setting pattern to 0 size no longer gives an endless loop of error messages.
• Auto serialization no longer crashes in French.
• Undo reduce points no longer scrambles points on screen.
• Added option in Rulers and Grids dialog to show grid as dots instead of lines.
• Improved compatibility with Photoshop plug ins so that application will no longer close or 

exit on trying to change some settings.
• New option added to the File Paths tab of Preferences to force software to always use 

the same document folder.
• Rasterize dialog that comes up when you send a lens to RIP, now shows more detailed 

information on what will be rasterized and give progress bar. It defaults to 1/4 the printer 
resolution.

• Selecting a preset in RIP and Print dialog that uses a 3rd party ICC now will properly set 
the linearization file and ink limits with RIP and Print.

• Improved text handling in EPS/PS import filter.
• Importing EPS or PS files now better recognized the font names and will not prompt for 

font substitution if the font is already installed.
• Auto-scroll as you drag near the edge of the screen has been optimized to accelerate as 

you move further from the design.
• Installing to a very long foldername no longer stops sciImport.dll from loading and 

causing a crash.
• Snap to edge now properly snaps to the edge of the object during drag.
• Clicking with zoom tool will now re-center the image.
• Improved compatibility with previous version kerning.fkn files.
• Pantone colors no longer display muted when printed to an Acrobat PDF file.
• Sending a file from RIP and Print with an incorrect embedded ICC profile will no longer 

report "Failed to initialize color management module". Instead, the incorrect ICC will be 
substituted with a valid one.



Templates
• Apply template now has new options "Selection only", "Include Border" and "Include 

substrate color".
• Used colors and used fonts placeholders now allows line spacing to be specified.
• Color and fonts of dimensions and labels will no longer be shown in template. In addition, 

overall dimensions will not be affected by these objects.
• Used Color Placeholder tool has an option to specify the swatch size.
• Job info Placeholder tool now shows more items without scrolling in DesignCentral
• Job info Placeholder tool now has options to insert Height, Width, Scale, Tax %, Subtotal. 

Scale will show as a ratio such as 1:100 or 1:12.
• After applying a template, all data from Job Info is automatically placed into the new 

design.
• Active drawing placeholder has an option to set scale if desired (for example 25% or 

1:10).
• If multiple template objects are selected, they can be edited. Previously, DesignCentral 

would not show any template data. This makes it easier to change the font for multiple 
items.

• Template option has been removed from preferences>tools

Macintosh Specific Enhancements
• Job Properties can now be resized.
• Network Production Manager no longer crashes after sending two contour cut jobs.
• Add Setup is now faster after the first setup is added.
• Solved slow output cutters with small buffers (Gerber, Roland, Wild, Zund, etc).
• Gretag Eye One no longer prompts to calibrate white reference each time before 

measuring.
• Tear off palettes are no longer grayed out once dragged.
• Added support for X-Rite DTP-41 using a USB-Serial adapter.
• Fixed tab order in rectangle DesignCentral page.
• Command "=" shortcut now allows zoom in, in addition to command "+".
• Encad NovaJet 850/880 now support 1x4 and 2x4 CMYK printing.
• Jobs with names longer than 28 characters can now be added to the queue.
• Hasp key driver has been updated to version 1.8.
• Aborting a job in production manager no longer shows status as "Driver is not good".
• Added "Ignore Overprint" option to the print dialog.
• Added support for Apple scrolling mouse.
• Fixed a random crash when desktop printing previously saved documents.

Windows features added to the Macintosh
• Transparent bitmap support
• Two spot color gradients
• Multiple color palettes
• Tangential Entry/Exit
• Snap to Center of Gravity
• Duotone Spot Colors
• Finisher/Underbase Effects
• Create Swatch
• Nesting in Production Manager
• Job Priority & Scheduling
• Print background as white
• Pantone Mapping with Global Color Mapping
• Automatic Tile Flip
• Ability to save native files larger than 2GB
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Driver changes
• Infiniti: Merged Infiniti and Infiniti II drivers together and and fixed a typo in the Infiniti XML 

file that would lead to "Incorrect Printer Model" in some print modes.
• Yaselan driver has been changed to support new Yaselan API.
• Graphtec FC5100 now properly supports poll size. Note that this fix requires a new 

firmware from Graphtec in addition to the updated driver.
• Kwangko: Unidirectional printing now supported.
• Gerber GS15plus no longer stops cutting or has stray cuts
• Graphtec contour cut mark changed from 1cm to 2cm
• Mutoh multi-segment support added using AL6. Number of segments if fixed. Works with 

advance after plot on.
• Roland SP300: Vacuum setting is properly set in driver.
• Summa DC3 no longer swaps some spot colors.
• Teckwin: Added white support and support for files over 2GB.
• GCC Jaguar III no longer has a 1in shift between print and cut.
• Mutoh Toucan LT now allows new media to be added, and saved. (problem with XML 

file)
• DGI: BMP preview now considers tiling, layout, etc.

New Drivers
• Graphtec: JH80016s, Duojet 64
• Roland: GX-24
• Mutoh: Spitfire, Osprey, 8100

Localization Issues
• Inspire import added to Spanish, Portuguese and German
• Roland driver for languages was wrong for languages (AmRDFJ740.dll). Overlapping of 

controls hid passes field.
• Summa USB port support added to all languages
• Clear Preferences has been renamed to "Preference Manager" for all languages
• Bitmap and Vector intent are no longer swapped in French, Spanish or German.

Color
• Improved gradient smoothing, especially after scaling an image.
• PDF files print whites no longer print as yellows (bug that absolute colorimetric was 

getting applied for LAB for Pantone implementation)

Other
• Clear Preferences no longer gives an error if there are no production preferences
• Bitmap driver now supports nesting
• Contour cut marks are no longer offset if colorbands are enabled on hybrid devices.
• Gerber PLT import improved to import some files that came in empty previously.
• Driver options are not properly applied for jobs sent from the color profiler.
• Color adjustment preview now works no matter what screen setting is used (16 or 32 bit 

screen).
• Some TIFF files with Macintosh format embedded ICCs will not load.


